
KØRETØJSSENSOR 

 

FVD-L 
 
 

Fordele: 
• Magnetoresistive sensorer PNP+NPN 
• 3-dimentionel måling af køretøjers og store 

jernholdige objekters tilstedeværelse i feltet 
• Erstatter vejsløjfer og andre former for 

vejbanesensorer 
• Ingen behov for potentiometerindstilling eller 

eksterne styringer 
• Let at installere i fortove, vejbaner, 

betongulve o.lign. 
• 2 LED visning: stand by (grøn) udgang (rød 

eller gul) 
• Beskyttelsesgrad IP69K; NEMA 6P 
• Beskyttet mod kortslutning 
• Kompakt design, små dimensioner: 

77 x 19 x 7,5 mm 
• Installation manuelt eller med software 

 

 

Funktions princip: 

FVD-L sensoren bruger en passiv følerteknologi til at måle 
tilstedeværelse af jernholdige genstande i feltet. 
Sensoren måler simpelthen forskellen mellem jordens 
omgivende magnetiske felt og feltet for den indtrængende 
jernholdige metalgenstand. 
FVD-L sensoren erstatter derved direkte vejsløjfer. 
Sensoren kan tilsluttes direkte til et relæ eller indgang i en 
styring. 
Det bedste resultat opnås når sensoren anbringes under 
jordens overflade, midt i en kørebane, men kan også under 
visse omstændigheder monteres over jorden. 

 
Virkemåde: 

FVD-L sensoren indeholder tre magnetoresistive 
transducere, der hver især føler på det magnetiske felt 
langs én akse. Ved at bruge sensorerne i hver sin akse 
x,y,z, opnås den største følsomhed. 
En metalholdig genstand vil ændre på det lokale 
(omgivende) magnetiske felt, når den føres hen mod 
sensoren. Størrelsen på ændringen i det magnetiske felt er 
dels afhængig af genstanden ( størrelse, form, orientering 
og sammensætning) dels det omgivende magnetiske felts 
styrke og orientering (i hvilken retning af de tre akser det er 
kraftigst). 

 
Med en simpel programmering af sensoren måler sensoren 
på det omgivende magnetiske felt og bliver herved neutral 
til feltet. Sensoren lærer det omgivende felts styrke at 
kende. Når en stor jernholdig genstand ( f.eks. en truck, bil, 
lastbil eller sporvogn) nærmer sig sensoren, ændres det 
magnetiske felt og sensoren måler ændringens størrelse. Er 
ændringen af det magnetiske felt så stor at det når de 
forprogrammerede grænseværdier, vil sensorens udgange 
aktiveres. 

FUNKTIONSPRINCIP 



FVD-L - Køretøjssensor 
Sensorens rækkevidde og følsomhed: 

 
Sensorens følsomhed er afhængig af tre faktorer 

1. Det lokale miljø (inklusive nærværende magnetiske materialer). 
2. De magnetiske egenskaber for den genstand der kommer mod sensoren 
3. Sensorens indstillinger 

 
FVD-L sensoren kan måle ændringer af det magnetiske felt i alle retninger. Som ved andre sensorer vil følsomheden 
være afhængig af målet. En kraftig forstyrrelse af en stor jerngenstand vil aftage efterhånden som afstanden til 
sensoren øges. Dæmpningen (ændringen) og følsomheden overfor forstyrrelsen er afhængig af genstandens form og 
sammensætning. 

 
Sensoren kan programmeres til at være mere eller mindre følsomme, overfor forstyrrelser i det magnetiske felt, ved at 
bruge to justeringer (indstillinger); baggrundsforhold og følsomhedsniveau. 
Når niveauet for følsomhed og baggrundsforholdene (de omgivende betingelser) er indstillet og lagret i hukommelsen, 
er sensoren klar til brug. 

 

 

Niveauer og grænseværdi 
 

FVD-L sensoren kan indstilles i 6 niveauer (hvor niveau 1 er det mindst følsomme og niveau 6 det mest 
følsomme) forskellen mellem to niveauer er et udtryk for en højere eller lavere grænseværdi i forhold til det 
omgivendes felts værdi (som regel 0, hvis sensoren er korrekt justeret).I sensoren er der indbygget en 
forstærkning af signalet en såkaldt gain faktor. Gain faktoren er indstillet fra fabrikken og kan ikke ændres. 
Forholdet mellem de forskellige niveauer og de fabriksindstillede grænseværdier fremgår af tabellen nedenfor. 

 
Hvor godt sensoren reagere, er som tidligere nævnt afhængig af miljøet sensoren er placeret i, de magnetiske 
egenskaber for objektet der føres ind i feltet, samt sensorens indstilling (grænseværdi). 
Det er derfor mulig ved programmering at finjustere sensorens egenskaber. 
Sensoren er fabriksindstillet til niveau 5. Det betyder at sensoren ved en given afstand er dobbelt så aktiv end en 
sensor indstillet til niveau 3. Graferne herunder illustrerer forholdet mellem to niveauer henholdsvis for placering 
ved siden af køretøjet og for en sensor nedgravet. 

 
Bemærk at dæmpningen ikke er kontinuerlig når et køretøj nærmer sig eller kører forbi en sensor, specielt for en 
sensor placeret under en kørebane. Det skyldes det faktum at selve køretøjet ikke er en homogen masse af metal. 
Dele som motor, - der normalt ligger foran, og aksler har en større virkning på sensorens omgivende magnetiske 
felt, end selve karosseriet. 

 
 

NIVEAUER OG GRÆNSEVÆRDIER 
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Indstilling af sensoren 
 

Sensoren indstilles (lærer omgivelserne at kende) med den grå ledning. Den grå ledning er altid aktiv, og sensoren kan 
genindstilles hvornår det skal være. Optimal indstilling med den grå ledning, opnås ved at montere og fastgøre sensoren 
så den ikke kan bevæge, sig hverken før under eller efter indstillingen. 
Programmeringsimpulser udføres ved at føre den grå ledning gennem en normal åben kontakt til sensorens blå 
minusledning. Ved at aktivere kontakten én eller flere gange indstilles først baggrund og derefter ét niveau (kontakten 
aktiveres så mange gange som tallet på niveauet er, dvs. én gang for niveau 1, og seks gange for niveau 6) se skema. 
Programmeringsimpulser kan også udføres med et lavvolt (< 2Vdc) signal fra en PLC. Anvendes en PLC til indstilling af 
sensoren, kvitteres modtagelse af signalet med udgangssignal fra sensoren. 
Sensoren kan indstilles i 6 niveauer, hvor niveau 1 er det mindst aktive og niveau 6 det mest aktive niveau (sensoren er 
fabriksindstillet til niveau 5). Når sensoren først er indstillet og lært omgivelserne at kende, beholdes denne indstilling, 
selv ved strømudfald. 

 
VIGTIG, når den grå ledning ikke anvendes, skal den lægges til (plus +) gennem en 10Kohm´s modstand, for 
at undgå antenne effekten, der kan virke forstyrrende på sensoren. 

 

INDSTILLING AF SENSOREN 
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FVD-L sensoren anbringes i midten af en kørebane, herved 
opnås det bedste og mest effektive (reproducerbare) 
resultat. Ved erstatning af en kørebanesløjfe (et induktivt 
loop), vil det geometriske center for sløjfen være en god 
placering for FVD-L sensoren. 

 
Ved anbringelse i siden af kørebanen, skal der tages 
hensyn til anbringelse og bevægelse af metalgenstande 
modsat kørebanen, indenfor korte afstande til sensoren, 
også selv om bevægelsen ikke vil være synlig. 

 
FVD-L sensorens smalle hus gør, at den med lethed kan 
placeres i fortove med et enkelt savspor på 
1cm i bredden. Fjern løse genstande i savsporet, placer 
sensoren og fyld sporet op med gummi eller anden form for 
flydende pakning (ikke varm). Fyld aldrig varm asfalt i 
sporet. Sørg for at pakningsmaterialet kommer godt 
omkring sensoren så denne ligger stabilt og ikke kan 
bevæge sig. 
Kablet er et specialkabel der kan tåle alle former for 
fyldmateriale varmt som koldt. Den ideelle 
monteringsdybde er 10 cm. 

 
Udskiftning af defekt sensor, gøres ved at trække i kablet 
fra styringssiden vinkelret på sporet. Denne 
fremgangsmåde får både kabel, størknet 
pakningsmateriale og sensor med op af sporet. 

Bemærk: for at opnå det bedste resultat ved 
registrering af køretøjer, anbring FVD-L 
sensoren under jordoverfladen, midt i en 
kørebane. 
På steder hvor det kun kan lade sig gøre at 
anbringe sensoren over jorden, ved siden af 
kørebanen ( f.eks. ved billetluger, bomme og 
indkørselskontrol) skal det sikres at der ikke findes 
andre bevægelige dele der kan øve indflydelse på 
sensoren. 

 
FVD-L sensoren er en ikke retningsbestemt 
sensor. Sensoren kan monteres i hvilken som helst 
position uden det har indflydelse på dens 
føleregenskaber. Udvælg et sted så tæt som muligt 
på det køretøj der skal registreres. Brug hullerne i 
endekappen til at fastgøre sensoren til underlaget, 
der kan anvendes et hvilket som helst underlag 
(f.eks. beton eller jern), betingelsen er at sensoren 
skal gøres fast og må ikke kunne bevæges. 

 
 
 
 

 
 

 

 
 
 

NEDGRAVET SENSOR OVER JORDFLADEN 

MÅL OG LEDNINGSFORBINDELSER 



Magnetoresistive Vehicle Detection Sensor - FVD-L 
 

 

 Technical Specifications  
 

Passive 3-axis magnetoresistive transducer 

Adjustable range by configuration (See figure 4) 

10 to 30 Vdc 

Two SPST solid-state outputs conduct when object is sensed; 

one NPN (current sinking) and one PNP (current sourcing) 

100 mA 

Short-circuit 

10 mA maximum (each outut) 

NPN saturation: <200 mV @ 10mA and <600 mV @ 100 mA; 

OFF-state leakage current: < 200 microamps 

PNP saturation: <1,2V @ 10 mA and <1,6V @ 100 mA; 
 

OFF-state leakage current: < 5 microamps 
 

Reverse polarity and transient voltages 

-40º C to +70ºC; 100% Max. rel. humidity 

20 milliseconds 

0,5 seconds 

< 0,5 milligauss/ºC 

2 LED: green (power), red/yellow (configuration/output) 

Impedance 12K ohms 

Shielded 5-conductor polyethylene jacketed attached cable 

   Dimensions  
 
 
 
 

77 mm 

 
 
 
 
 

 
2xØ4 mm 

 

 
 
 
 
 
 
 

   Connections  
 
 

Brown   

Blue 

White 

Black 

IP-69K (NEMA 6P) 

Housing: anodized aluminium, End caps: PVC 

Grey test 

 
 
 
 

Available types 

Model Cable length Cable type Supply voltage Output type Range 

FVD-L-9 
FVD-L-15 
FVD-L-30 

9 m 

15 m 

30 m 

 
5-wire shielded cable 
with 4mm diameter 
polyethylene jacket 

 
 

10 to 30V dc 

 

Bipolar 
NPN/PNP 

 
Range varies, depending 
on application and target 

being sensed 

 

Vare nummerer 
FVD-L9 : Kørebanesensor 
**************************************** 
FVP : PROGRAMMERINGSBOX 
**************************************** 
FVC : PROGRAMMERINGSKABEL 
USB 1.1/R232: USB CONVERTER 

 
Bennike & Wander 
Håndværkerbyen 57 
2670 Greve 
Tlf. 43 90 80 00 
bewael@bewael.dk 

Type of detection 

Detection range 

Supply voltage 

Output configuration 

 
Output current 

Output protection 

Output ratings 

 
 
 
 

 
Supply protection 

Operating conditions 

Response time 

Delay at Power-Up 

Temperature effect 

Indication 

Remote TEACH input 

Connections 

Environmental protection 

Construction 
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Plus 
 

Minus 
 

Plus  
Modstand over 

10 Kohm 

 
 
 
 

Med denne installation, kan man sætte sit 
programmeringsudstyr på og se hvad der sker, uden 

at slukke for spænding til føleren 

Vare nummer 
Kørebanesensor 
FVD-L9 
FVD-L15 
FVD-L30 
********************** 
Programeringsbox 
FVP 
********************** 
Spændingsstik til FVP box 
V-DCHAN-10 
********************** 

 
Bennike & Wander, 
Håndværkerbyen 57 

2670 Greve 
43 90 80 00 



FVD-L GUI Help  

Release 1.0 (P/N 75495) 
  
The FVD-L GUI allows a user to acquire the real-time data and configure the settings of the FVD-L 
sensor. This help document is intended to describe the layout of the GUI and explain the use of each 
GUI screen. 
  
  
1.0 Standard Data Acquisition 
  

 
  

Figure 1.  Standard Data Acquisition Screen 
  

The Standard Data Acquisition screen is shown in Figure 1, and is the default screen. This screen 
allows a user to acquire the real-time data of the sensor, and graph the sensor count versus time in 
the Standard  panel. The data acquisition is started by pressing the Start button. The user can choose 
to log the data or acquire data without logging. 
  
The Settings panel contains the communication parameters and the sampling rate. The Port setting 
selects which COM port the computer communicates with the sensor on. This setting must match the 
COM port that the RS232C cable is connected to on the computer. Currently the COM ports can 
range from 1-20. The Sample Time setting is the rate at which the sensor is polled for new data. The 
minimum sample time is 20msec and the default is 500 msec. 
  
  
1.1  Thresholds Data Acquisition 
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Figure 2.  Thresholds Data Acquisition Screen 
  

The Thresholds Data Acquisition screen is shown in Figure 2. This screen allows the user to graph 
the sensor count versus time. The current threshold values are also displayed in the Thresholds 
panel. 
  
  
1.2  Advanced Data Acquisition 
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Figure 3.  Advanced Data Acquisition Screen 

  
The Advanced Data Acquisition screen is shown in Figure 3. This screen allows the user to graph 
the individual real-time axis counts versus time, along with the sensor count of the sensor in the 
Advanced panel. 
  
  
2.0 Configuration Settings Screen 
  
The Configuration Settings screen is accessed by pressing the Configure button from the 
Standard or Advanced Data Acquisition screens. All of the panels in this screen have Read 
Config  and Write Config buttons. When the Read Config button is pressed, all of the data for the 
currently selected panel is read from the sensor. When the Write Config  button is pressed all of the 
data on the currently selected panel is written to the sensor. The data in the unselected panels is not 
read/written. When data is changed it is highlighted yellow, and is un-highlighted when it is actually 
written to the sensor.  
  
  
2.1 Ambient, Thresholds, & Hysteresis Panel 
  

 
  

Figure 4.  Ambient, Thresholds, & Hysteresis Panel 
  
The Ambient, Thresholds, & Hysteresis  panel is shown in Figure 4. This panel allows the user to 
configure the ambient levels, threshold levels, and hysteresis levels. The ambient levels can be re-
measured by pressing the Reset Ambient Levels button. This causes the sensor to re-measure the 
ambient magnetic field in the X, Y, and Z planes. The individual axis values of the ambient magnetic 
field are displayed in the Base X, Base Y, and Base Z fields. The Sensor Count is displayed to show 
the current sensor count at the time that either the Read Config or Reset Ambient Levels  button is 
pressed. When the ambient levels are reset, the Sensor Count should be close to zero (i.e. the sensor 
is zeroed out).   There are 6 threshold levels that can be configured within the range 20-5000, and 
there are 6 hysteresis levels that can be configured within the range 20-255. The Threshold Selector 
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is used to configure which threshold and hysteresis levels are used by the sensor. Correct operation 
of the sensor requires that the hysteresis level be less than or equal to the threshold level. Figure 5 
shows a diagram describing the interaction of the threshold and hysteresis levels. 
  

 
  
  
2.2 Outputs, Device Info, & Restore Panel 
  

 
  

Figure 6.  Outputs, Device Info, & Restore Panel 
  

The Outputs, Device Info, & Restore panel is shown in Figure 6. This panel allows the user to 
configure the output settings, read the device info, and restore the sensor back to the factory default 
configuration settings.  

Threshold Level 

Hysteresis Level 

Ambient Level 
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The settings that can be configured in the Outputs section are the White/Black Wire Configuration 
(PNP/NPN), the White/Black Wire Polarity (Active Above Threshold/Inverted), White Black Wire 
Output Mode (Signal Tracking/One Shot), and the Output One Shot Time (1-255 msec, default is 
125 msec).  
  
The Device Info is read-only, and consists of the Hardware ID/Version number and the Software 
ID/Version number. 
  
The Restore Factory Defaults button will cause the sensor to restore its configuration settings back 
to the factory defaults that are stored in the sensor. This will also cause the GUI to re-read all of the 
configuration settings into all of the panels.  
  
  
2.3 Drift Filter Panel 
  

 
  

Figure 7.  Drift Filter Panel 
  
The Drift Filter panel is shown in Figure 7. This panel allows you configure the drift filter for the 
sensor. Currently, the drift filter is disabled by default. The Time Constant can be selected to be 15 
minutes, 1, 4, 12, or 24 hours. The Threshold is the maximum amount of deviation in the magnetic 
field (from the previous reading) on each individual axis, before the drift filter is automatically 
disabled (the drift filter is meant to correct for SLOW changes in the ambient magnetic field, small
variations of any material, like for example the position of the sensor can change because the cable
will pull, or push the sensor when the weather is hot, or cold (mechanical action on metal regarding
amniant temperature)).  
  
  
3.0 Menus 
  
The FVD-L GUI has a simple menu with two main sections, File and Help. The GUI can be exited 
via the File menu and this help can be accessed via the Help menu. Figure 8 shows the Open Config  
and Save Config  items of the File menu. The configuration data of the sensor can be imported from 
or exported to an XML file. 
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Figure 8.  Open Config & Save Config 
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                                                   Montage forslag 
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